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2 Ruskin

Ruskin is the RBR software that manages your RBR loggers to provide all the data necessary to do your work. Ruskin 
provides a graphical user interface that makes using the loggers easy. You can use Ruskin to do the following:

• configure, schedule and enable multiple loggers
• download data after logging
• graphically view data sets
• export data in various formats
• change the calibration coefficients for your logger

Ruskin can be used on PC and Mac.
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3 Revision history

Revision No. Release Date Notes

1.0 01-Sep-2012 Original

2.0 01-Oct-2014 Adding RBRsolo D and DO and RBRduet
support

B 12-Sept-2017 Final revision for compact loggers

D 12-Dec-2018 Updated installation details, updated 
screenshots, added auto-deploy features

E 13-Mar-2019 Updated plotting information, firmware 
upgrades, and screenshots
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4 Warranty statement

All data loggers manufactured by RBR Ltd. are warranted against defects in workmanship or original parts and 
materials for one year. Third party sensors (not manufactured by RBR) are limited to the warranty provided by the 
original manufacturer.

Units suffering from such defects will be repaired or replaced at the discretion of RBR Ltd., provided that the problem 
has appeared during normal use of the instrument for the purpose intended by us. The liability of RBR Ltd. extends only 
to the replacement cost of the instrument. The customer will bear all costs of shipment to us for repair; all other costs, 
including return shipment, will be borne by RBR Ltd.

This warranty does not cover consumables or normal wear and tear, nor does it cover damage caused by negligent use 
or mishandling. Attempted modification or repair of any unit without the prior consent of RBR Ltd. will immediately 
void any warranty in force.

Users are expected to maintain a regular program of calibration.

We reserve the right to grant or refuse warranty repairs at our discretion if we consider that there are reasonable 
grounds for doing so.
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5 Introduction

This document introduces you to Ruskin and helps you to use it effectively from the start. It is specifically written for the 
RBRsolo3 and RBRduet3 loggers - our smallest one and two channel loggers.

You can access the Ruskin User Guide on the USB data stick provided when you purchase a logger, from the Help menu 
in Ruskin, and on the RBR web site, at www.rbr-global.com.

Release notes are automatically displayed each time you install an updated version of Ruskin. The most recent release 
notes are also available from the Help menu in Ruskin.For information about operating and maintaining your data 
logger, see the Logger Hardware section. It helps explain how to change the battery and change desiccant, including 
other useful information, such as inspecting and replacing O-rings.
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6 Installation

6.1 Install Ruskin on a PC
You can install Ruskin on a PC that runs the Windows 7, 8, 8.1, or 10 operating system.

The minimum requirements for Ruskin are:

• OS = Windows 7
• Processor speed = 1.4GHz 
• RAM required = 1GB 
• Display resolution = 1024x768 recommended 
• HDD space for installation = 300MB

Steps

1. Connect the data stick included with your instrument to a USB port.
2. Navigate to the folder Ruskin Installation and double click on the file RuskinSetup.exe.
3. Follow the installation wizard. By default, Ruskin will be installed to C:\RBR.
4. The logger uses a USB interface to communicate with Ruskin.

At the end of the installation, a prompt will appear asking, "Would you like to install the logger driver 
at this time?"

5. Click Yes to install the drivers.

A shortcut to Ruskin appears on the desktop and in a Start menu folder called Ruskin.

6.2 Install Ruskin on a Mac

You can install Ruskin on a Mac running OS X 10.5 (Leopard) or later.

Steps

1. Insert the USB data stick in the appropriate USB port.
2. Navigate to the folder OSX and double click on the file Ruskin.dmg.
3. When the disk image window opens, drag the Ruskin icon into the applications directory and wait for 

the copy to complete.
4. To open Ruskin for the first time navigate to your applications directory, locate Ruskin, right click on 

the icon, and select Open.

You may need to run the setup application as an administrator to install the driver correctly.

Please note that the most recent version of Ruskin can be found at https://rbr-global.com/products/software

https://rbr-global.com/products/software
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5. The dialogue box shown below will prompt you to authorize the opening of Ruskin. 

An application named Ruskin appears in the Applications folder.

You may want to drag the Ruskin.app application to the Dock.

6.3 Update Ruskin
To take advantage of new features and bug fixes, ensure that you are using the most recent version of Ruskin.

It is not necessary to uninstall an older version of Ruskin before installing a newer version. The installation program 
deletes the older files before installing the newer ones. It does not delete any Ruskin data files or log files.

The most recent version of Ruskin is always available on the RBR website (www.rbr-global.com). However, if you 
already have an older version of Ruskin installed, Ruskin automatically notifies you that a newer version is available 
when you start Ruskin. You can check to see if a new version is available from within Ruskin navigating to the 
menu Help > Check for updates. If you have a broadband connection, we recommend that you follow the installation 
instructions that appear on your computer. Otherwise, request a USB stick from RBR.  

6.4 Uninstall Ruskin
If you no longer need to manage RBR instruments from your computer, you can uninstall Ruskin.

It may be required that you navigate to System Preferences > Security & privacy to allow apps downloaded 
from “Anywhere” to complete the installation.



Although you can specify a different folder for the working directory for the software, we recommend that you 
use the default Applications folder.



If you do not have a broadband connection and/or are unable to install the Ruskin updates, update 
notifications are available via email. To receive these notifications, send an email to: support@rbr-global.com
subject: "Ruskin update request".



http://rbr-global.com/support/software
mailto:support@rbr-global.com?subject=Ruskin%20update%20request
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It is not necessary to uninstall an older version of Ruskin before installing a newer version. The installation program 
deletes the older files before installing the newer ones. For more information, see Update Ruskin.

Windows 7, 8, 8.1, or 10

Go to Start > Control Panel > Programs, and under Programs and Features, click Uninstall a program. In the list, 
locate Ruskin – click Ruskin to highlight it, and then click Uninstall.

OS X 10.5 or later

Move the Ruskin application from Applications to the Trash.

Removing Ruskin will not delete your data files or your diagnostic logs.
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7 Provide your feedback
You can get in touch with RBR in several different ways:

• Send us an email.  For a technical question, write to support@rbr-global.com. For general inquiries, 
use info@rbr-global.com.

• Send us a bug report from within Ruskin itself.  Use the Help menu > Comment on Ruskin.  
This allows you to include the diagnostic logs, and any other files (RSK datasets, screenshots) that will 
help us reproduce the problem and help you as quickly as possible.

Steps

1. From the Help menu, click Comment on Ruskin.
The Feedback to RBR dialog box appears.

2. Enter your identification information, for example, email address and name, and then summarize 
your comments. 

3. Provide a detailed description and add any attachments, if required. 
4. Click Submit to submit the report. 

mailto:support@rbr-global.com
mailto:info@rbr-global.com
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8 Quick start

8.1 Deploy an instrument
Before you begin using your RBR loggers, you may want to experiment with the simulated loggers that are included in 
Ruskin. For instructions on simulating a logger, see Simulating an RBRsolo/duet.

When you are ready to use your own RBR loggers, we recommend that you follow the following steps to ensure that you 
measure exactly what you want on the first attempt. 

Steps

• To establish communication between the RBRsolo3 or RBRduet3 and a computer, open the 
instrument (see Opening and closing the logger) and remove the housing. There is a USB-C connector 
located on the back side of the logger. The supplied interface USB-C cable is plugged into this 
connector and the other end is attached to the USB port on your computer.

• The logger should appear in the Navigator view after a few seconds.
• If you are using the logger for the first time, you can use either the default preferences or specify your 

preferences to apply to all your loggers. For more information, see Preferences. You can change these 
preferences at any time.

• Click the logger that you want to use. Ensure that it contains the sensors you expect to find on the 
logger by viewing the Information tab in the Properties view on the right side of the Ruskin window. 
For more information, see View information about a logger.

If you want to see live data sampled every few seconds but not saved, select the Fetching button in the toolbar located 
above the Plot view. The Plot view is located at the bottom of the Ruskin window.

• If you want to view or modify calibration coefficients, click the Calibration tab. For more information, 
see Calibration tab.

• Click the Configuration tab > Sampling section to schedule the logger to take samples when and as 
often as you want within the limits of your logger.
 For more information, see Scheduling a RBRsolo/duet.

Ruskin prevents you from enabling a schedule that exceeds the memory capacity of the logger. Ruskin also shows the 
estimated battery usage required to use your logger as scheduled. You should seriously consider this information 
before you enable the schedule. 

• If you want to download data, click the Download button from the Configuration tab to download all 
the data saved since your schedule was enabled. For more information, see Download. The focus 
changes to the new dataset in the Navigator view, and the static data appears in the Plot view. You 
can now export the downloaded data to a file in Excel or text. You can also save the image as a PDF or 
PNG file for viewing outside Ruskin.

 

You must specify your preferences regarding these features before you enable the schedule. For more 
information, see Configure a logger.


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8.2 Simulating an RBRsolo/duet
Ruskin can simulate most logger types that RBR produces, including the RBRsolo3 and RBRduet3. We recommend that 
you experiment with your type of simulated logger before enabling a schedule for your actual RBR logger. This practice 
will probably save you time in the long run by ensuring you are familiar with the options available.

Steps

1. From the Instruments menu, click Simulate instrument. The Configure Simulated Instrument dialog 
box appears.

2. Under Logger type, select the Compact Instruments tab and select the appropriate options.
3. Click OK. The simulated logger appears under Instruments in the Navigator window.
4. Click the new simulated logger. You can work with this logger the same way as you work with a real 

RBR logger, including: configuring, calibrating, logging, and downloading data. Multiple loggers, both 
real and simulated, are listed in your Navigator window.

8.3 View information about a logger

You can view static information about a logger at any time as follows:

In the Navigator view, click the appropriate logger.

The Information tab in the Properties window on the right side of Ruskin identifies the logger. Its general information 
such as model, serial number, generation, firmware version, battery status, and the channels.

If you want to remove a simulated logger, right-click it and click Remove simulated instrument. You can also 
use the Instruments menu.


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8.4 Recover an instrument and download data
When the deployment is complete recover your instrument and follow these steps to download your data.

Steps

• Start Ruskin
• Carefully open the logger by unscrewing the pressure housing
• Insert the USB-C connector into the logger and connect cable to your computer
• The logger appears in the navigator window and select the Configuration tab and select 

Download... (see Download)
• Save the file to a preferred location
• Evaluate your data (see Analysis) 

Flooded loggers may be under pressure and opening a logger may be dangerous - take precautions when 
opening a logger


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9 Configure a logger
Before you enable a logger schedule, you can configure the logger to suit your requirements.

The instructions to configure a |tide or |wave logger are different than the standard loggers and can be found in Tides 
and Waves.

If your logger schedule is already enabled when you decide to change the configuration you must stop running the 
schedule, make your changes, and enable the schedule again. However, any data stored so far on the logger will be 
lost.

The Configuration tab contains the Enable, and Use last setup buttons. When you click Enable, the logger setup 
parameters are stored to the logger and the schedule is enabled.

Use last setup is intended for configuring multiple loggers using the same schedule. For example, to set up three |tide 
loggers with exactly the same parameters, set one logger up and enable it; connect the second and third logger and 
when you click Use last setup button, these two loggers will be set up with the same parameters as the first logger. This 
includes the logger clock time, start and end logging times, sampling period (or rate), gating condition, and tide or 
wave sampling parameters for |tide or |wave loggers.

9.1 Scheduling a RBRsolo/duet
You can schedule your RBRsolo3 or RBRduet3 to start at a specified time and sampling rate. Ruskin indicates any 
unattainable conditions in the defined schedule at the bottom of the Configuration tab, and the Enable button is 
grayed out.

Steps

1. Connect your logger locally to computer's USB port. The logger should appear in the Navigator view 
after a few seconds.

2. While the logger you want is highlighted in the Navigator view, click the Configuration tab in the 
Properties view.

You can preserve the data by downloading it to a file before you enable the schedule again.

https://docs.rbr-global.com/display/RSKDOC/.Tides+and+Waves+vD
https://docs.rbr-global.com/display/RSKDOC/.Tides+and+Waves+vD
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3. Click either UTC sync to synchronize the logger with Coordinated Universal Time, or Local sync to 
synchronize the logger with your local PC clock.

4. In the Start boxes, specify the date and time that you want to start running the schedule or select 
the Now check box to populate the current date and time.

5. Specify the interval between samples using the Speed option. If the Rate box is not selected you have 
the ability to set the sampling interval in units of seconds. The Rate option allows you to select 
between 2,4,8,16,24 and 32 Hz frequencies.

 
6. An estimated end logging is shown at the bottom of the Configuration tab based on the sampling 

interval set. Check to ensure this date is beyond the end date of your planned deployment. The green 
and red bars next to the End date shows whether memory or battery is the limiting factor for the 
deployment. For the above instrument, it can log for 16.1 days based on memory, with a further 24.2 
days of battery capacity remaining. 

7. If the logger you are scheduling has had a fresh battery inserted, select the Fresh battery box. Ruskin 
has the capability to calculate the remaining battery life available for a used battery based on the 
number of samples that have been taken. The RBRsolo3 and RBRduet3 keep track of the number of 
previously stored samples to determine the battery use. Selecting and deselecting the Fresh Battery
check box allows you to see the difference between a fresh battery and a used battery.

8.  To enable the logger to start sampling immediately or in the future click Enable. A message appears 
informing you that the memory will be erased. 

9. Select Cancel if you need to download the previously sampled data or press Erase and enable 
logging to enable the logger.

9.2 Stop logging
Logging stops on its own when one of the following occurs:

• The end logging time is reached.
• The power is removed.
• The logger memory is filled.
• The logger battery is depleted.

To manually stop the logger In the Properties view, click Configuration tab and select Stop logging.

If you select and then clear the Now check box, you can then manually modify the current date and 
time instead of the original values.



All profiling loggers (known as |fast) have the ability to sample faster than 2Hz. For example |fast32 
loggers sample at rates of 2,4,8,16,24 or 32Hz. All |tide loggers can average at rates of 2,4,8 or 16Hz. All |
wave loggers can sample at rates of 2,4,8 or 16Hz



If you select the Fresh battery box and enable the logger the previously stored sample count is reset. 
In this case it is assumed that a fresh battery is installed.



 Whether or not you make any changes to the schedule or the configuration, before running the schedule 
again, a warning appears that the contents of memory will be erased. If you want to save the data stored so far 
on the logger, you must download the data to a file before proceeding. You can do this from Properties view > 
Configuration tab and select Download. For more information about downloading a file, see Download.


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9.3 Waves and Tides RBRsolo/duet

9.3.1 Tides 

|tide loggers use averaging to remove wave data from the pressure measurements. |wave loggers can be set up to 
operate like |tide loggers.

From the Configuration tab select the mode Tide to enable the tide measuring regime.

• In Sampling specify how fast you want pressure readings to be taken. Select in Speed either a 
period of 1s or slower or a rate for sub-second sampling rates.

• In Sampling specify the tidal averaging Duration (how long to average) and specify the tidal 
measurement Interval (the interval between averages). 

 In the above example the averaging rate is set to 2Hz and the averaging duration is 1 minute and this measurement is 
repeated every 5 minutes. 

9.3.2 Waves

A |wave logger records both wave and tide information, and the configuration is different from other loggers. For 
additional information on planning a wave deployment, please refer to Appendix D - |wave deployment planning.

This section applies to the RBRsolo3 D |tide and |wave and RBRduet3 T.D |tide and |wave loggers

This section applies to the RBRsolo3 D |wave and RBRduet3 T.D |wave

All |wave loggers automatically calculate tide data by averaging the wave burst data. There is no setup 
required to determine tide information with the wave logger. 



http://docs.rbr-global.com/display/RSKDOC/.Appendix+D+-+%7Cwave+deployment+planning+v5
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From the Configuration tab select Wave as the mode to enable the wave measuring regime.

• In Sampling, specify how fast you want pressure readings to be taken. Select in Speed either 
a period of 1s or slower or a rate for sub-second sampling rates.

• In Duration (samples), select the number of samples that you want to take during a wave burst. The 
range is between 512 and 32768 samples.

• In Interval, enter the interval between the bursts for the wave measurement period.
• In Instrument altitude (m), enter the number of meters above the sea or river bed where the logger 

will be secured in place. This value is used when making wave bandwidth estimates.
• In Mean depth of water (m), enter the total expected depth of the water where the logger will be 

deployed. This value is used to estimate the range of wave frequencies and periods that can be 
resolved.  Ruskin calculates the actual depth from the measured pressure data post-deployment.

9.4 Autoranging and fixed gain
Turbidity sensors are capable of autoranging. The logger can change the gain setting on the front-end amplifiers in 
order to select the most appropriate range based on the environment being measured. The logger can also set the gain 
on the sensor to a fixed value selected by the user, rather than allowing the logger to select the gain as it measures.

From the Configuration tab under logger details there is a drop down menu where the Range of the sensor can be 
specified. Seapoint turbidity sensors are capable of autoranging (automatic gain setting) or having a fixed range of 
2500, 500, 125 or 25 NTU.
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Range change events are displayed in the Plot view when the Display diagnostic is selected from the Events button, 

, located in the Plot view toolbar. Range change events are displayed as RANGE XX Units where XX indicates the 
current range and units are the units of the sensor – typically NTU for turbidity sensors and μg/l for fluorometers. For |
fast sampling where the change may be occurring over a number of samples the event is displayed as RANGE CHG and 
is followed by the final range event.

9.5 Deployment

Once you have ensured that the batteries are fresh, inspected the O-rings and programmed the logger (see Configure a 
logger), the instrument is ready to be deployed.

There are four precautions you should take to avoid damaging the logger and maximise the deployment autonomy:

1. Pay attention to the maximum pressure rating. All loggers with pressure sensors are individually rated 
to a maximum depth/pressure. This is indicated by the label which is placed on the logger's sensor 
end cap. Loggers which do not have a pressure sensor do not have this label, but are limited by the 
maximum depth/pressure rating of either the logger housing itself or of the sensors.

2. Avoid physical stress to the logger. Any type of clamp or bracket which concentrates the stress to the 
logger body is not recommended for use in logger mooring, mounting, and/or other deployment. 
Stress due to improper mounting may cause the logger to leak, resulting in the loss of valuable data or 
permanent damage to the electronics. RBR can provide proper mooring and mounting clamps suited 
to your specific application.

3. Use desiccant. If the logger is closed up in a warmer environment than the deployment environment, 
internal condensation can result. Since condensation may cause the circuitry to malfunction, the 
installation of desiccant prior to deployment is strongly advised.

4. Orientation on a mooring. Due to battery capacity potentially being sensitive to cell orientation, it is 
best to mount the logger with the sensor end facing down when deployed. Even if batteries that are 
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minimally sensitive to cell orientation are used (e.g. Tadiran), it is always good practice to mount the 
loggers in this manner in the event that any brand of battery is employed.

9.6 Automatic Tasks
When working with a large number of similar instruments, Ruskin offers various automatic tasks, which can be toggled 
on and off from the Instruments menu, or by right-clicking the "Instruments" group in the navigator view.  Icons 
indicating the current state will be displayed on the "Instruments" group.  Since these tasks can change the state of the 
logger, the on/off state defaults to off each time Ruskin is run.

Figure 1.  Instruments menu showing automatic tasks options.  If a task is enabled, it will show a check mark.

Figure 2.  Right-clicking on the "Instruments" group of the navigator view will show the automatic tasks.  If a task is 
enabled, it will show a check mark.

Figure 3.  "Instruments" group of the navigator view with icons indicating that auto-download and auto-deploy are 
enabled.

9.6.1 Auto-Download
When an instrument is detected, it will automatically start a download process and store the file using the common 
logger download naming scheme (serial number, date and time of download) in the last "save to" directory chosen.  
Other than possibly creating unwanted files, this option is safe since it does not alter the state of the logger.
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9.6.2 Auto-Stop
When an instrument is detected, it will automatically stop the instrument if the instrument was previously enabled.  If 
auto-download is not also selected, a warning will be displayed about downloading the instrument data.  It is not 
possible to re-enable the instrument without erasing the instrument's memory, so it is advised to also use the auto-
download feature at the same time, or ensure that the data is downloaded prior to re-enabling the instrument.

9.6.3 Auto-Deploy
When an instrument is detected, the instrument will be stopped and then reprogrammed with the last known 
configuration settings.  It is highly recommended to also use auto-download with this setting since the instrument 
memory will be erased during the deployment set up.  To use this feature, first connect an instrument that will act as 
the model and configure that instrument with the desired settings and then turn on auto-deploy.  Each instrument 
connected, if it supports the same capabilities of the model instrument, will be configured to match the scheduling of 
the model instrument.  Auto-deploy implies auto-stop since the instrument must be stopped to update it with the new 
schedule information.
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10 Download

10.1 Download data from the logger
You can download data from a logger at any time. If you stop running a schedule, you must download the data before 
you restart the schedule to prevent the data stored so far from being lost. It is not possible to start logging without 
erasing the memory contents.

Steps

1. From the Configuration tab select Download. 
The Save as RSK dialog box appears.

2. Specify a location and a name for the data file. 
By default, the RSK file name uses the Ruskin file naming convention. For more information about the 
naming convention, see File naming convention below. 

3. The name of the new dataset appears and is highlighted automatically in Navigator view > Datasets. 
The Properties view changes to the new dataset and contains the following 
tabs: Analysis, Overview, Channels, and File Info. All the data that was stored on the logger at the 
time of the download is automatically plotted in the Plot view.

10.2 File naming convention
In Ruskin, by default, the name of a data file is composed of the following information:

• The first six digits represent the logger serial number.
• The next eight digits represent the current year, month, and day.
• The next four digits represent the current time to the minute.
• The file extension indicates the file format and should not be changed. If you change it, the file 

extension that you specify becomes part of the name, and the required extension is appended.

For example, the file named 911936_20090522_1613.rsk contains data for a logger with a serial number of 911936 
whose data was downloaded in 2009 on May 22 at 4:13 pm.

Downloading data again while the same schedule continues to run, picks up the same data plus any data 
stored since the last download.
You can add a comment after downloading a dataset.


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11 Calibration tab
The Calibration tab displays the calibration coefficients for each parameter (sensor) present and the date and time of 
the last calibration. Selecting the sensor from the dropdown menu Parameter toggles between the calibrations for the 
different sensors on the unit.

You can request a calibration quote for your logger by selecting Request calibration quote and sending the 
information directly to RBR Ltd. In the Calibration tab, click Request calibration quote, and when the Request 
calibration dialog box appears, enter the appropriate information. Make sure to verify that all information is correct 
before sending the request. You can edit any of the coefficients and use Store calibration to save the new coefficients 
to the logger.  Use Revert calibration to recover to the original coefficients if you have not already selected Store 
calibration. 

Calibration coefficients are calculated for each sensor, and the coefficients are stored in the logger. Calibration 
certificates are provided for each sensor and contain both the calibration equation and the coefficients. Hard copies are 
provided with each shipment, and the documents are contained inside the shipping box. Please refer to the calibration 
certificates for the coefficients and residuals. RBR can replace lost or misplaced calibration certificates.



RBR#0006106revE  –  25

12 Update firmware
Instrument firmware upgrades can be performed from within Ruskin without having to return the instrument to the 
factory. Ruskin automatically checks to see if a newer version of firmware is available and displays a message in the 
Information tab.

Click the Update firmware button to upgrade the logger firmware. The following screen will appear:

Do not disconnect the logger until the process is fully completed. Disconnecting the logger during this process 
may render the logger inoperable.


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If for some reason RBR needs to supply a version of firmware, the following method is used to manually update the 
logger firmware.

Click the Instruments menu > Update logger firmware. 

Steps

1. In the Instruments menu, click Update logger firmware. 
The Update logger firmware dialog box will appear. 

2. Click the instrument drop down to select the instrument you wish to upgrade.
a. A default firmware image will be selected for your instrument. 
b. If RBR supplied a firmware file click the Select file button and browse to the location of the 

firmware update file provided. The file will have the extension .rbrfw.
3. Click Proceed to start the firmware upgrade. 

A progress bar shows the status of the upgrade. Once the firmware upgrade is complete, the message 
Update completed successfully appears at the top of the dialog box.

4. If the upgrade doesn't complete successfully, click Proceed again to retry until successful. 

5. Click Close.

Contact RBR for instructions before proceeding. This method of updating the firmware should only be 
attempted with the assistance of RBR.



Occasionally the logger will not reappear in the Navigator view following a successful upgrade. If this 
occurs, disconnect your logger from the USB port and then reconnect to re-establish communication.


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13 Datasets

13.1 Open a stored dataset
You can open any stored dataset to explore its contents.

Steps

1. Click File menu > Open dataset. 
2. Double-click the .rsk file that contains the data that you want to view. 
3. The name of the dataset appears and is highlighted automatically in the Navigator view. The 

Properties view changes to the dataset. The data in the file is automatically plotted in the Plot view.

13.2 Analysis

13.2.1 Analysis tab
The Analysis tab contains information and settings for configuring the calibration information and to display statistical 
information. You must already have an open dataset to view and configure these settings. For information about how 
to open a dataset, see Download.

Cursor tab
When a file is selected and plotted, the Analysis tab can be selected to display information about the dataset channels 
and their values.

To close a dataset, right-click its name in the Navigator view and click Close dataset. Or use File > Close 
dataset



Ruskin performs an integrity check that is intended to make sure that older data files are compatible 
with newer versions of Ruskin software. This information is displayed in File info. If the file requires 
updating the message indicates the issue with the file, and how long an update will take.
RBR strongly recommends that all files that have issues be updated.


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This table reports the value at each sample number when selected in the plot referenced to the vertical black cursor.

The sample number and time of the sample are displayed.

Selecting Display statistics gives you the ability to determine the average value and standard deviation over a range of 
samples. Change the number of samples in the average by using the spin buttons. The grey bar that appears on the plot 
view is the range of the samples in the average.
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Calibration tab
When a file is selected and plotted for re-calibration the Calibration tab can be selected to assist with calculating 
calibration coefficients, see User calibration .

13.3 Overview
When a file is selected and plotted the Overview tab can be selected to display general information about the dataset.

This is also the form on which you can enter a comment for the dataset and then press Save comment to save it.

13.4 Channels
The Channels tab displays three additional tabs: Information, Calibration, and Parameters.

The Information tab displays the measured parameter, the sensor manufacturer and the range setting. The type of 
derived channels and how it is calculated is displayed in a separate table.

The Calibration tab displays the calibration coefficients for each sensor.

The Parameters tab displays the values of the parameters, default values if other required parameters are required 
and the method used to calculate the derived channels.

13.4.1 Information tab
The Information tab displays the measured parameters, the sensor manufacturer and the range setting (if applicable). 
It also shows any derived channels that are available, and a description of the methodology used in the calculation of 
that derived parameter.
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13.4.2 Calibration Tab
The Calibration tab displays the calibration coefficients and temperature correction coefficients (as applicable) for 
each channel (sensor) and the date and time of the last calibration.
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You can edit any of the coefficients and use Store and recompute data to recalculate the dataset. Use Revert 
calibration to recover to the original coefficients if you have not already selected Store and recompute data. To 
recover the original calibration coefficients edit one of the values and click in another cell. The Use deployment 
calibrations check box then becomes active and unchecked. Check this checkbox to restore the coefficients used by 
the logger and then press Store and recompute data to save the coefficients.

13.4.3 Parameters tab
When a file is selected and plotted, the Parameters tab can be selected to display the parameters used to calculate any 
applicable derived channels.

The tab reports the relevant derived channel information for the sensors on the logger. The parameters can be edited 
to change the derived channel calculation. Once a parameter is modified, the Update and recompute and Revert 
settings buttons become active.

Revert settings rereads the RSK file and populates the form with the parameters from the file. Update and 
recompute writes the new parameters to RSK file and re-displays newly calculated data.

The following example is for a  CTD and dissolved oxygen logger where you can change the calculation parameters to 
calculate the derived channels:

 

Selecting the Seawater derivation in the Parameters tab results in a depth calculation based on UNESCO Technical 
paper 44.

The depth derivation equations can be found under the menu item Options menu > Preferences > Derived 
Channels > Depth tab. 

For |wave loggers you can change the wave calculation by adjusting how the depth is calculated and by adjusting the 
instrument altitude.

13.5 File info
When a file is selected and plotted the File info tab can be selected to display information about the file.
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If the message A new version of the RSK file format is available. appears, click Update. The update process may take 
some time, however, Ruskin does estimate the time with the message The anticipated update duration is <time 
period>. 

13.6 Plot view
You can use the Plot view to view a graphical display of data in datasets or live data. When viewing live data, the logger 
must still be attached.

A toolbar at the top of the Plot view contains various buttons to help you customise, explore, and export the graphical 
display.

Each channel appears as a different colour in the graphical display. These colours are specified for all graphical displays 
in Options menu > Preferences > Plotting and can be changed only there. You can also change other defaults affecting 
the Plot view in Preferences. For information, see Specifying plotting preferences

You can click a particular time (location) in the plot to view each channel value and related statistics at that time. A 
"double lollipop" vertical black line marks the place. The Cursor tab panel above (or on the side of the plot for live 
data) displays the channel values, units, the sample number, and the time that the data was measured.

For datasets only, you can select the Display statistics check box to view the average value and standard deviation for 
each channel based on the number of samples that you specify. 

If you want to copy the data to the clipboard and then paste it into another application, select a row, a column, a cell or 
click on the word channel for the entire table and then click Copy. 

The graphical display for each dataset appears on its own tab in the Plot view. The dataset file name appears at the top 
of the tab.

Files created by older versions of Ruskin must be updated to ensure compatibility. Failing to do so may result 
in odd graphical display and incorrect reporting of the sample values.



Scaling of the data is based on the on the minimum and maximum value sampled for each channel - 
sometimes there are erroneously high or low values that may make the real data appear incorrect. Use the 

vertical zoom   to increase the scale of the data displayed.


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13.6.1 Thumbnail view
A downsampled representation of the dataset appears in a thumbnail view, along with an indicator of the current 
plotted time range.  The indicator can be positioned on the thumbnail view by clicking on the thumbnail view or 
dragging the indicator.  The indicator can be resized by dragging the edges, which will zoom the plot along the time 
domain to match the new indicator size.  The thumbnail always shows time-domain data, even if the plot is switched to 
depth-domain mode.

13.6.2 Live data
You can use the Plot view to view a graphical display of logger sampling.  The data can come from one of two sources: 
fetching or streaming.  Fetching can be used on a logger that is either not enabled, or enabled without a streaming 
option.  Streaming can be used on a logger that has been enabled.  If fetching is used on a logger with streaming 
selected and the logger is enabled, the current file used for the fetching data will be closed and a new file started for the 
streaming data; fetching will be disabled.

The graphical display for live data for each logger appears on its own tab in the Plot view. The logger model and serial 
number appear at the top of the tab.

13.6.3 Plot Tools

Dataset toolbar

Live data collection support in Ruskin is intended for debugging, development, and schedule trial purposes 
only and is not intended as a robust data collection solution.  Performance will degrade significantly if large 
(>50-100K samples, depending on hardware) data collections are performed, especially if there are a large 
number of events being reported.


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Live plot toolbar
The live plot toolbar appears to the right of the dataset toolbar.

Tools for datasets and live data

Button Purpose Use

Filter Changes the type of annotation for the navigation 
buttons

• If an annotation is selected, switching filters zooms the 
view to the newly selected annotation.

• If no annotation is selected and switching filter from one 
profiling annotation type to another (profile, upcast, 
downcast), the view does not change.

• If no annotation is selected and switching filter between 
categories (profile, upcast, downcast to any other non-
profiling annotation type, or any non-profiling annotation 
type to any other annotation type), the view moves to the 
first annotation of the new category.

• Comment → Profile moves to first profile
• Profile → Comment moves to first comment
• Comment → Downcast moves to first downcast
• Profile → Downcast does not move.

Move to 
first, 
previous, 
next, and 
last

Move to the first, previous, next, and last annotation of 
the filter type

If annotation is selected also moves selection

Index The current annotation index, which can be edited.

If the currently selected annotation matches the time 
domain extent the text will appear blue, otherwise the 
text will be red

Click middle of index (the '/' ) to zoom to the annotation.
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Button Purpose Use

Create 
annotation

Select type of annotation to create.

After selection, click and drag left/right on main plot to 
create the annotation. When the click is released the 
annotation will be created as a temporary annotation, 
selected, and show its editable tooltip.

Profiles or geodata cannot overlap the same type - new 
annotations will fill the available space between existing 
profiles.

Cast 
detection

Runs a cast detection algorithm based on depth and 
conductivity to automatically generate profiles and casts

Event 
visibility

Turn on and off visibility of the various levels of events 
(error, warning, information, and diagnostic)

Zoom 
control

Zoom in/out horizontally, vertically, and reset zoom to 
display the maximum extent of each axis

Zooming the range will center the data on the currently 
selected sample.

The annotation must be edited (such as adding a 
title or description, or, in the case of profiles, by 
adding an up or down cast) and saved (press 
ENTER/Return, or click the green check mark on 
the tooltip) before it will be saved in the RSK file.



Only available in time domain

Overwrites logger generated cast events and 
profiles


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Button Purpose Use

Auto-
ranging

Toggles the auto-ranging of the channel axes

Export plot Exports the current view of the main plot to pdf or png

Data 
rendering 
type

Choose lines, shapes, or lines and markers for the trace 
lines

Toggle 
channel 
visibility

Turn on or off channels to be visible in the plot view

Toggle on raw values removes the calibration equation 
from the sensor value

Plot by 
depth

Toggles between plot by time and plot by depth

Disabling the auto-ranging of the axis can be 
useful for looking at trends in data



If no data appears in the Plot view, try changing 
the rendering to "Display Markers".  Time spans 
that are larger than expected will cause breaks 
between data points and lines will not be drawn 
connecting those points, whereas markers draw 
at each individual point.



If there is no depth channel the plot would then 
use the next pressure or pressure derived channel 
starting from the bottom of the channel list


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Tools for live data

Button Purpose How to use

 
Toggle the 
side data 
panel

The side data panel appears beside the charts and shows the 
file location that will be used to capture samples, the number of 
samples collected, the values of the last received sample, and 
the currently selected sample.  The side panel can be toggled on 
and off with this button.

Live plot time 
range 
selection

Click the button to display a drop down list of time span options 
to display the data by time period. For example, display 2 
minutes of data. You can also choose to display all of the data 
collected.

Start or pause 
fetching

The logger supports either streaming or fetching data. Fetching 
is the action of asking the logger to take a reading and report it. 
Ruskin displays the fetched data every 1-2 seconds. Fetching is 
disabled if the logger is enabled and has streaming turned on.

13.6.4 Shortcuts / Controls
• Data cursor:

• Click on the main plot to set the data cursor (double lollipop indicator).
• Move to the previous/next data sample: Left/Right Arrow Key

• To move by hundreds of samples, use Shift - Arrow
• To move by ten thousands of samples, use Alt - Arrow
• To move by millions of samples, use Shift - Alt - Arrow

• Annotations
• Double click on an annotation bar to zoom in to the range of the annotation.
• Click and drag on the edge of an annotation bar to resize the annotation, if the annotation is 

resizeable (CELL GPS annotations are not).
• Click and drag on the annotation bar to move the annotation, if the annotation is moveable 

(CELL GPS annotations are not).
• Main Plot

• Double click on the plot to reset to fully zoomed out.
• Shift-click and drag on the plot to select a zoom region.  The zoom region will be denoted by a 

rectangle.  Make sure to press shift before clicking.
• Control-click and drag on the plot to pan the plot.  Make sure to press control before clicking.
• Mouse wheel will zoom the plot in/out based on the current mouse position.

• Main Plot Axes
• Double-click on an axis to set the axis to auto-range (show the full range of data).
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• Click and drag an axis to pan the axis.
• Shift-click and drag an axis to zoom the axis in or out.
• Mouse wheel will zoom the axis in/out based on the current mouse position.

• Thumbnail
• To resize the viewable range, click and drag on the handles (gray bars) on or use the mouse 

wheel within the viewable range indicator.
• Click and drag the viewable range indicator to pan
• Click on a region not covered by the viewable range indicator to center the viewable range at 

that location.

13.7 Exporting datasets
You may want to share your data with others or analyse your data using other software. You can export data as a text 
file, which can then be imported into many applications, or export it in a particular format for analysis such as Microsoft 
Excel or OceanDataView.

You must already have downloaded the data to a dataset or opened an existing dataset.

Steps

1. Right-click the dataset whose data you want to export, and hover to Export as to open a submenu, or 
use File menu > Export dataset.

2. Select the appropriate export format (Excel, Text, OceanDataView or Bin). The exports found under 
the Legacy formats are not appropriate for newer instruments and so are not discussed here.

3. Specify a location and a name for the data file. 
4. Click Save.

Exports to Matlab may fail if the RSK file size exceeds 20MB. Alternatively, an RSK file can be imported 
directly into Matlab with our toolkit RSKtools that is available for download from our website at 
www.rbr-global.com. The RSK file is a single file database based on SQLite that allows us to have very 
large files with high-speed access to any part of the dataset.



Large files may not export completely into any of these formats. Large files should be converted 
to .txt and processed after the fact. The legacy Excel export is limited to 65000 rows



http://rbr-global.com/support/matlab-tools
http://www.rbr-global.com/support/matlab-tools
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14 User calibration
 

Change calibration coefficients

Sensors such as the dissolved oxygen sensor that can be field calibrated will require you to update the calibration 
coefficients for these channels periodically. You may also need on occasion to manually enter new coefficients, 
although this is not recommended for factory calibrated sensors (for example T or D) unless instructed by RBR.

Steps

You can view static information about an instrument at any time as follows:

1. In the Navigator view, under the Instruments list, click the appropriate logger.
2. Click Analysis tab > Calibration tab to show the current calibration coefficients.
3. To manually change a coefficient, click on the appropriate entry in the table (C1, C2, C3, etc.). The 

current entry will be highlighted, and the new value can be typed.
4. If a two point calibration has been performed, and calculated coefficients have been copied, right 

click on either the Time or Parameter entry for the parameter you wish to modify. Select Paste to 
selected row from the drop down menu.

5. Click Store calibration to write the calibration coefficients to the logger.
6. If you need to revert to previous coefficients, click Revert calibration.

14.1 N-Point calibration
Sensors such as Dissolved Oxygen (Oxyguard) or turbidity generate a voltage output that is proportional to the value of 
the parameter being measured. To calibrate these sensors, Ruskin offers an N-point calibration method to generate 
calibration coefficients.

14.2 Oxyguard DO calibration

Equipment

1. Two Large mouth beakers

If you do not click Store calibration, the coefficients will not be written to the instrument, and will be lost 
once your session is closed. 



The Oxyguard DO sensor has a true zero point and therefore it can be calibrated using the single-point 
calibration method using a reading at 100% oxygen concentration only. The 100% calibration should be 
performed at the expected temperature and salinity of the deployment environment.
If the logger has a pH/ORP sensor and Oxyguard DO sensor, it is advisable to ensure that the pH/ORP and 
Reference sensors are submerged in the water during measurement.


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2. Sodium sulphite Na2SO3
3. Aquarium air pump
4. Magnetic stirrer

Preparing solutions

 Reference Point 1 solution – Oxygen saturated solution at expected temperature and salinity of deployment 
environment

1. Fill the large beaker with 2 L of water. And install magnetic stirrer.
2. Bubble air through the water using an air pump (an aquarium air pump would work).  
3. Switch ON the air-pump and the magnetic stirrer.

Reference Point 2 solution – Dissolved oxygen concentration of zero

1. In a beaker, dissolve approximately 5 tsp of sodium sulfite (Na2SO3) into 500 mL tap water.  
2. Mix the solution thoroughly with a magnetic mixer. The solution will be oxygen-free after 15 minutes. 

 

Steps

1. In Ruskin, configure the instrument to sample at a fast rate, between 6 Hz and 3 seconds. 
2. Use Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the end time is 

set so that the logger will keep sampling until calibration is complete.
3. Submerge the dissolved oxygen sensor in the Reference Point 1 solution for at least 15 minutes near 

the stirrer so that it is in the best mixed area of the bath.
4. Take sample readings for at least 15 minutes for the 100% calibration point, making note of the time 

that the sample is being measured.
5. Submerge the dissolved oxygen sensor in the Reference Point 2 solution for at least 15 minutes for the 

0% calibration point, making note of the time that the sample is being measured.
6. Retrieve the data from the data logger as per the steps in Download.
7. The calibration data should now be displayed in the Plot view. In the Properties view, go to Analysis

tab > Calibration tab.
8. Select the dissolved oxygen sensor type from the drop down list. 
9. The Number of Samples spinner box is automatically set to 100. 

This value is the number of sample points Ruskin will average the calibration coefficients for the 
sensor. Typically, this value should be in the range of 50 to 100 samples.

10. Click on a stable point in the Plot view corresponding to 100% oxygen. In the table in the first row, 
under Real Avg, enter 100 and press enter. 

11. Select the check box in the second row in the table, then click on a stable point in the Plot view 
corresponding to 0% oxygen. In the table in the second row, under Real Avg, enter 0 and press enter.

12. Ruskin automatically calculates the calibration coefficients, and these values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.

13. Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the 
data logger.
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14.3 Turbidity calibration
The Seapoint turbidity sensor is calibrated by RBR with a two-point calibration technique. We recommend to do a two 
point calibration performed under fluorescent lighting.

Alternatively, one can do a single point calibration. If doing a single "0" point calibration in disstilled water the 
calibration will only correct the coefficients for an offset.  If only a single non zero point is performed the callibration 
will recompute the slope coefficient. We recommend to only perform a "0" point calibration unless you are confident on 
your non zero standard.
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14.3.1 Two-point calibration
Equipment (entire logger submerged)

• 4000-FTU Formazin standard – 500 ml
• Distilled water – 5 L
• Black-walled, wide-mouth container (large enough to hold the logger)
• Volumetric flask 1000 ml, class A
• Volumetric flask  200 ml, class A
• Stir stick

Steps (preparing solutions)

1. In Ruskin, configure the data logger to sample using a 10 second sampling interval and set the sensor 
to autoranging - see Autoranging and fixed gain. 

2. Use Sync to PC to ensure the logger clock is synchronised to the PC clock, and ensure the end time is 
set so that the logger will keep sampling until calibration is complete.

3. Flush the sensor, container and glassware with distilled water and dry them.
4. Fill the black wall container with 5000 ml distilled water using the large volumetric flask.
5. Set the sensor in the container until the sensor is fully submerged in the distilled water. 

6. Record the data in distilled water for five minutes. 
This is the zero-turbidity calibration point.

7. Fill the 500 ml volumetric flask with Formazin Standard. Remember to gently shake the bottle before 
opening the Formazin solution.

8. Add 500 ml Formazin Standard to the black wall container with distilled water, and gently mix the 
solution with a stirring stick.

9. Calculate the value of the standard turbidity solution at calibration point according to following 
formula: 
 

10. After five minutes, remove the logger from the calibration container and wash the sensor head under 
regular tap water.

11. Retrieve the data from the data logger as per the steps in Download. 
12. The calibration data should now be displayed in the Plot view. In the Properties view, go to Analysis

tab > Calibration tab.
13. Select the Tu sensor type from the drop down list.  

If you plan to submerse only the sensor, you can decide on the container volume and adjust the solution 
volumes appropriately.



The distance from the sensor's windows to the container wall must be at least 20 cm. If possible, place 
a dark cover on the calibration container and avoid direct light on the container.



Calculating dilution
TuSTD = TuSTK*VTOT/(VDW+VTOT) = 363.63 FTU
Where:
TuSTD = turbidity of the standard solution (FTU)
TuSTK = 4000FTU – turbidity of the stock solution
VTOT = 500 ml volume of stock solution at calibration point (ml)
VDW = 5000 ml - initial volume of distilled water


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14. The Number of Samples field is automatically set to 100. 
This value is the number of sample points Ruskin will average calculate the calibration coefficients for 
the sensor. Typically, this value should be in the range of 50 to 100 samples.

15. Click on a stable point in the Plot view corresponding to 0 NTU. In the table in the first row, under
Real Avg, enter 0 and press enter. 

16. Select the check box in the second row in the table, then click on a stable point in the Plot view 
corresponding to reading of your turbidity solution. In the table in the second row, under Real Avg, 
enter the value of your turbidity solution and press enter.

17. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.

18. Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the 
data logger.

By using the above formula and changing the volume of distilled water and Formazin solution, you can 
prepare different calibration points or different volumes for checking linearity of the turbidity sensor or getting 
close to real turbidity value of standard turbidity solution.


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14.3.2 One-point calibration
Using the same procedure as in the 2-point calibration, one can use only the distilled water or formazin standard to 
generate new coefficients from a single point.

RBR suggests to use the one point calibration for establishing a new "0" value only, as unless one is very confident on 
their non zero point they may put the unit out of specification.

After you have generated a dataset of your single point as described in the procedure above follow the setps below:

1. Retrieve the data from the data logger as per the steps in Download. 
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2. The calibration data should now be displayed in the Plot view. In the Properties view, go 
to Analysis tab > Calibration tab.

3. Select the Tu sensor type from the drop down list.  
4. The Number of Samples field is automatically set to 100. 

This value is the number of sample points Ruskin will average calculate the calibration coefficients for 
the sensor. Typically, this value should be in the range of 50 to 100 samples.

5. Click on a stable point in the Plot view corresponding to 0 NTU. In the table in the first row, 
under Real Avg, enter 0 and press enter. 

6. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.

7. Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the 
data logger.
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15 Preferences
Ruskin sets global preferences that require no changes in many situations. However, as you learn more about what 
Ruskin can do, you may want to change some of these defaults to better suit your requirements. The global preferences 
include:

• where to store output files
• plotting preferences
• configuring derived channels
• calculating derived channels when sensors are missing

You can change these preferences at any time.

15.1 Specify location for data files
You can control where data files are stored by default. Specify these locations before downloading any data.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In File location, type a directory name in the Directory for RSK files text box, or click Browse to 

locate the directory where you want to store data files. 
4. Click Apply or OK.

You can change where future data files are stored by default at any time. The change takes effect immediately.

15.2 Specify location for realtime data files
You can control where realtime files are stored by default. Specify these locations before connecting any instrument.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In File location, type a directory name in the Directory for realtime RSK files text box, or click 

Browse to locate the directory where you want to store data files. 
4. Click Apply or OK.

You can change where future data files are stored by default at any time. The change takes effect immediately.

15.3 Specify location for log files
You can control where log files are stored by default. Specify these locations before downloading any data.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.

Realtime files are generated when a connected instrument is streaming or when the user enables fetching 
mode on the instrument.


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3. In File location, type a directory name in the Directory for log files text box, or click Browse to locate 
the directory where you want to store log files. 

4. Click Apply or OK.

You can change where future log files are stored by default at any time. The change takes effect immediately.

15.4 Specify Language selection
Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In Language selection, select a language from the list. 
4. Click Apply or OK.

15.5 Using advanced sampling controls
 Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In Sampling control, select Enable advanced sampling controls check box to change from the 

simple control.
4. Click Apply or OK.

15.6 Using advanced calibration controls
 Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In Calibration control, select Enable advanced calibration controls check box to change from the 

simple control.
4. Click Apply or OK.

15.7 Derived channels RBRsolo/duet

Log files are used when you request RBR support.

Simple control: provides a default list of fixed values.
Advanced control: provides the user the ability to enter any values.



Simple control: provides the user the ability to view and edit the main coefficients (C) for any channel.
Advanced control: provides the user the ability to view and edit all main and dependency calibration 
coefficients (C,X) for all channels.



Ruskin calculates all the possible derived channels for that specific logger.
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The RBRsolo3 D and RBRduet3 T.D measure pressure and from that sea pressure and depth is derived. The RBRsolo3 DO 
measures percent dissolved oxygen saturation and from that dissolved oxygen concentration may be derived.  

15.7.1 Depth channel
To set up the initial values to derive depth and sea pressure select the menu item Options, then select 
Preferences, then select Derived channels and select the Depth tab. Enable the depth channel and select the 
appropriate calculation methods and edit the default parameters.

Enter the average expected Atmospheric pressure and the expected density of the water (default values are populated). 
There are two methods to calculate depth - select the appropriate method using the radio buttons. Sea Pressure is 
calculated by subtracting the Atmospheric pressure.  

15.7.2 Dissolved Oxygen concentration 
To set up the initial values to derive dissolved oxygen concentration select the menu item Options, then 
select Preferences, then select Derived channels and select the Dissolved 02 tab. Enable the Dissolved Oxygen 
channel and select the desired concentration units (µMol/L, mg/L or mL/L) from the drop down list.

For downloaded files, use the dataset Parameters tab to edit the parameters to derive the channel.

For downloaded files, use the dataset Parameters tab to edit the parameters to derive the channel.

http://docs.rbr-global.com/display/RSKDOC/.Channels+v5
http://docs.rbr-global.com/display/RSKDOC/.Channels+v5
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15.8 Specifying plotting preferences
You can specify how you want the graphical display in the Plot view to behave by default. With the exception of 
choosing colours for each channel, these preferences can be overridden for a particular graphical display in the Plot
view. 

15.8.1 Channel visibility tab
The Channel visibility tab displays many options to hide or show specific information in the Plot view. These settings 
are applied when displaying a dataset in the Plot view. Some information in this tab is enabled by default. When you 
select any of the check boxes in this tab, the action is immediate. 

Channel visibility tab with default settings

Steps

1. From the Options menu, click Preferences. 
2. In the list on the left side, click Plotting. 
3. On the Channel visibility tab, select the check box for the information you want hidden.  

Events appear at the x-axis as a vertical grey line with brief text to indicate the type of event, such as 

You can click Apply to save your changes without closing the dialog box.
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STP for a stop event in a dataset. Refer to Appendix A - Event and Error Stamps for a list of the event 
types. 

4. To hide all measured channels, select By default, hide all measured channels check box. 
5. To hide all derived channels, select By default, hide all derived channels check box. 
6. To show information, clear the check box beside the information you want shown. 

15.8.2 Channel colours tab
The Channel colours tab allows you to choose a different colour for each channel that is shown for information 
currently running in Plot view, or from an opened dataset. If there is no colour available that you like, you can create 
your own colour. When you select a colour, the new colour is immediately updated by Ruskin. 

Channel colours tab with the Colour dialog box to customize a colour for a channel

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click Plotting.
3. Click the Channel colours tab. 
4. In the channels listed, click the channel you want to change the colour for. 
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5. Click the colour box that appears beside the channel list. 
6. With the colour dialog box open, select a colour from the Basic colour area. 
7. Select OK to apply the colour to the channel. 
8. To create a custom colour: 

a. Repeat steps 4 and 5.
b. Click Define Custom Colours and then choose a colour. 
c. Click Add to Custom Colours to add the new colour to Custom colours.
d. Click OK to apply the new custom colour to the channel. 
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16 Logger Hardware

16.1 Opening and closing the logger RBRsolo/duet
To open an RBRsolo3 or RBRduet3 logger unscrew the sensor end counter-clockwise while holding on to the yellow 
housing. Once fully unscrewed, the housing can be carefully slid away from the sensor end cap, revealing the sensor 
carriage. The sensor carriage contains the battery compartment, desiccant holder and USB-C port.

Closing the logger is exactly the reverse of opening it. Remember to keep the O-rings clean and avoid scratching the O-
ring mating surfaces. Carefully inspect the O-rings before deploying the logger. Do not use excessive force when 
tightening the end sensor end; hand-tight is quite sufficient, as the seal depends upon the O-rings, not the end cap 
tightness.

16.2 Changing the batteries RBRsolo/duet
RBRsolo3 and RBRduet3 data loggers are powered by one (1) AA size 3.6V battery of any kind.
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To remove the battery, use either your finger or a blunt tool to push the battery from its holder using the keyhole 
opening on the back of the carriage.

To insert the battery, press the battery into the battery holder, ensuring it is correctly oriented with the negative 
terminal placed towards the electronics. The label in the logger indicates proper battery placement.

16.3 Installing desiccant RBRsolo/duet
The RBRsolo3 and RBRduet3 has a dedicated location for placement of desiccant in the sensor carriage, which will 
accommodate one (1) Dricap desiccant capsule (part # 02-01207AG35).

To remove the desiccant, use your finger or a pen to push through the small hole in the carriage and eject the 
desiccant. 



RBR#0006106revE  –  55

       

Insert a fresh desiccant capsule into the desiccant holder, ensuring that it is secure. 

16.4 Maintenance and repairs

16.4.1 Instrument calibration
We recommend that you verify the calibration of your data logger before any critical deployment, periodically once a 
year, or if you suspect the calibration to be out of specifications. Discuss your calibration needs with RBR. In some 
cases, you will be recommended to return the instrument to RBR to have it checked and re-calibrated. Please contact 
us for our current calibration fees.

16.4.2 O-rings RBRsolo/duet
The single most important item of maintenance on any RBR submersible data logger is care of the O-rings. Any kind of 
water leak can damage the circuitry beyond repair and cause complete data loss. Every logger's seal depends upon its 
O-rings, not the end cap tightness. Proper O-ring maintenance, therefore, is crucial. The RBRsolo3 and RBRduet3 use 
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two O-rings. One is the main O-ring and the other is the backup O-ring. Both O-rings are required to ensure that the 
logger does not become flooded. The correct placement and orientation of the two O-rings is critical to maintaining 
depth rating integrity.

The backup O-ring is flat on one side, and cupped on the other. When installing, the grooved side must be located 
towards the main O-ring.

Before you remove the O-rings from the RBRsolo or RBRduet, make yourself familiar with their orientation and location. 
Inspect the new O-rings provided in the loggers support kit – there are two types. The back-up O-ring is a flat O-ring 
with a concave channel on one side. The main O-ring is round.

Inspecting O-rings

Give particular attention to the following areas:

• The surface of the O-ring itself
• The mating surface on the inside of the case between the threads and the open end
• The inner surfaces of the groove in the end cap where the O-ring sits

Any dirt present should be removed by wiping thoroughly with a soft, lint-free cloth. When cleaning, never use any 
material or tool which could scratch the O-ring or any of its mating surfaces. If any dirt is present in the O-ring groove, 
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then the O-ring should be removed as described below to allow thorough cleaning of the groove. If an O-ring needs to 
be removed for any reason, it should be replaced. 
If the O-ring is scratched, cut, distorted, perished or defective in any other way it must be replaced. If any of the surfaces 
of the O-ring groove are scratched, pitted or otherwise damaged, the logger may need to be returned to RBR for 
refurbishment: please contact us for advice support@rbr-global.com.

Replacing an O-ring

1. Lever the O-ring from its groove. Use a soft plastic or wood tool; do not use a metal screwdriver or any 
other tool which may scratch the surfaces of the O-ring groove: doing so will probably render the end 
cap useless. Slide the O-ring out of its groove and off the logger. The O-ring may need to stretch quite 
a bit as it is pushed off; this requires some effort but can be done by hand.

2. Thoroughly clean the O-ring groove, taking great care not to scratch or damage it in any way. Inspect 
it carefully, and contact us for advice if it appears damaged. Apply a light film of silicone grease to all 
three inside surfaces of the groove, being careful not to trap any dirt, hairs or lint.

3. Select the proper O-ring and make sure it is not damaged. Lubricate it with a very light film of silicone 
grease to ease its installation. The correct order and orientation is as follows (assuming the o-rings 
have been removed): Install the main O-ring first by sliding it over the electronics housing (it is too 
small to fit over the sensor cap). Install the back up o-ring making sure that the concave part faces 
toward the sensor end and will mate with the main o-ring. The flat part of the backup o-ring must 
mate flat with the O-ring backing wall. Make sure there are no twists in either O-ring.

4. When the new O-ring is in place, inspect it once more for scratches and dirt, and wipe away any 
silicone grease deposited on the end cap.

Many experienced users of oceanographic equipment replace all O-rings before every deployment as a matter of 
routine. The cost of an O-ring is negligible compared with the cost of the instrument and its deployment. Routine 
replacement of O-rings, therefore, is cheap insurance.

RBRsolo and RBRduet: #2-115 N70 O-ring, 8-115 N90 backup ring

16.4.3 Repairs
We support all instruments and software that we manufacture. First line support is always available by phone, fax or e-
mail. Please contact us immediately if you are experiencing problems with your RBR product.  It is very important to 
contact us before returning your instrument, as some difficulties can be easily solved on-site by the user. Please have 
the model and serial number of the unit handy when you contact us at support@rbr-global.com.

There are no user-repairable parts of the logger. Any attempt at repair, whether successful or not, without prior 
authorization from RBR Ltd. will void the warranty. If it is necessary to return the product to RBR for an upgrade, repair, 
or calibration; please review the detailed shipping information on our website www.rbr-global.com before returning 
the unit.

In the unlikely event of an instrument requiring service at RBR, contact us for an RMA number and please use the 
following shipping address:

RBR Ltd
95 Hines Road Unit 5
Kanata, Ontario
CANADA K2K 2M5

Telephone +1 (613) 599-8900

For those who are shipping from outside of Canada, you will need to clearly mark the waybill and any other customs 
paperwork with the following:

mailto:support@rbr-global.com
mailto:support@rbr-global.com
http://rbr-global.com/support/service-and-repair
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"Canadian goods being returned to manufacturer for repair. NOT A SALE."

Please state the instrument value on the waybill as closely as possible to the current market value based on the original 
purchase price less depreciation. Please contact RBR if you have any questions about the instrument value. Send the 
unit using your own preferred method (prepaid).  However, we suggest that you do not use Ground Service, since 
customs brokerage charges will be billed incorrectly.

Units repaired under warranty will be returned prepaid by RBR.  Warranty repairs are decided on a case by case basis. 

Standard Repair Charges (Non-warranty)

Our minimum repair charge is $150 CAD. This charge covers a comprehensive initial check, including verification 
calibration and sensor functionality. Minor repairs are also covered by this basic fee. If further repair work or re-
calibration is necessary, a quotation will be issued to the customer. Once we have received authorization to proceed, 
the repair shall be completed and the instrument returned as soon as possible. Please note that any units returned with 
low (or no) batteries will have new batteries installed and the costs will be added to the repair invoice.

16.4.4 Support kits
To simplify maintenance of your data logger, RBR sells support kits with enough O-rings, and silicone grease for 5 
deployments. Please contact RBR for more information or to place an order.
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17 Appendices

17.1 Appendix A - Event and Error Stamps

The following is a list of event/error stamps that may be displayed in the data set.

TIMESTAMP - Time synchronization event, is used to ensure timing synchronization, whenever there is a possibility that 
the actual date/time of a sample according to the logger's internal calendar/clock does not match what is expected in 
the normal sampling sequence.

USER STOP - Sampling stopped by user, is used to indicate that a command to stop sampling occurred.

UNKNOWN - An unknown error has occurred, is used to indicate that the error has occurred in the logger and the cause 
of the error is unknown.

ERROR ## - Change event (system restart where logger clock is no longer valid), is used to indicate an internal error has 
occurred in the logger.

RESTART ## - Warm startup event (clock and programmed parameters are valid/unharmed), indicates a system restart, 
in which all programmed parameters are valid.

GAIN### - gain change event 

Below is a description of all the different event stamp types ## which could be encountered. Some of these are quite 
common, while others indicate very rare fault conditions. Some may also occur together in various combinations, with 
no sample data between them.

Error## code comment

00 eDATA_ERROR_CATCH_ALL generic/unknown/unexpected error

01 eDATA_ERROR_EOC A/D *EOC bit was set (should always = 
0)

02 eDATA_ERROR_DMY A/D *DMY bit was set (should always = 
0)

03 eDATA_ERROR_MODULE_ADDR invalid address used for RBR channel

04 eDATA_ERROR_OVERFLOW too much data to send to front end

05 eDATA_ERROR_BUS_BUSY access to internal bus denied
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06 eDATA_ERROR_TX_FAIL timeout sending command

07 eDATA_ERROR_RX_TIMEOUT timeout receiving response

08 eDATA_ERROR_PARSING generic failure to interpret response

09 eDATA_ERROR_NO_SAMPLE no sample was started

10 eDATA_ERROR_IN_PROGRESS sample acquisition still in progress

11 eDATA_ERROR_FAILED sample process failed somewhere

12 eDATA_ERROR_AVERAGE average computation error (no valid 
samples)

13 eDATA_ERROR_REPLY_SHORT front end reply contains fewer 
characters than expected

15 eDATA_ERROR_UNABLETOCOM
PUTE

unable to compute derived/cross 
channel
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